
Final Cut Pro X o� ers a whole new way to edit, with an ease of use 

that opens the door for millions of new users. DSLR cameras are also 

revolutionizing the way photographers, journalists, documentary 

producers, and directors bring their creative vision to life. Up until 

now, editing DSLR video has been anything but easy—syncing sound, 

transcoding footage, fi xing rolling shutter—but the “look” made it all 

worthwhile.

But shouldn’t things be easier? They can be. Users of all levels will learn 

how to edit DSLR video with Final Cut Pro X in this unique and targeted 

guide from the creative team behind the best-selling book on DSLR 

fi lmmaking—From Still to Motion: A Photographer’s Guide to Creating 

Video with Your DSLR. In no time you’ll learn how to successfully edit  

video with this groundbreaking new version of Final Cut Pro X.

• Import, analyze, and organize your footage and media

• Set up your projects correctly for any DSLR camera

• Fix common problems like rolling shutter and shaky video

• Implement essential and advanced editing techniques

• Work with synchronized sound and create compelling audio mixes

• Correct color and exposure problems with your clips

• Publish and share your productions to the web and mobile devices

• Download project fi les and videos that accompany the book by 
registering at www.peachpit.com/register.
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Introduction vii

Introduction

When we wrote the first book in this series—From 
Still to Motion: A photographer’s guide to creating video 
with your DSLR—our intent was to explore the entire 
creative process from preproduction through postpro-
duction. The feedback on that book has been over-
whelmingly positive, as have your requests for more 
details and workflows.

We’re glad to bring you the next book in this series—
From Still to Motion: Editing DSLR Video with Final Cut 
Pro X—to make the editing and delivery processes 
easier. Final Cut Pro X offers a whole new way to edit, 
with an ease of use that opens the door for millions 
of new users. Up until now, editing DSLR video has 
been anything but easy—syncing sound, transcoding 
footage, fixing rolling shutter—but the “look” made it 
all worthwhile.

We wrote this targeted guide on editing DSLR video 
with Final Cut Pro X to help you generate results imme-
diately. We wanted to strip away the many options and 
overly complex choices, and just focus on what a DSLR 
video shooter needs to become an editor. This book 
is for users of all levels who want to learn how to:

›› Import, analyze, and organize your footage and 
media

›› Set up your projects correctly for any DSLR 
camera

›› Fix common problems like exposure, rolling  
shutter, and shaky video

›› Implement essential and advanced editing 
techniques

›› Work with synchronized sound and create  
compelling audio mixes

›› Correct color and exposure problems with your 
clips

›› Publish and share your productions to the Web 
and mobile devices

Meet the Cast
This book is truly a team effort, much like the video 
production process. Because video is a multifac-
eted undertaking, we’ve come together to guide you 
through the process of creating a professional video 
using Final Cut Pro X.

The Authors
Meet the three authors behind this book. We’ve col-
laborated on each chapter to bring you the best of our 
collective knowledge.
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Richard Harrington

Richard Harrington is a director/
producer with national PSAs and 
Ciné award-winning productions. 
He is also a certified instructor for 
Apple and Adobe, and an expert 
in motion graphic design and dig-

ital video. He is a regular contributor to Creative COW, 
Photoshop User magazine, and numerous industry 
blogs. He also owns the visual communications com-
pany RHED Pixel (www.rhedpixel.com) in Washington, 
D.C. Rich is a member of the National Association 
of Photoshop Professionals Instructor Dream Team, 
manages conferences for the National Association of 
Broadcasters, and has written and co-written a num-
ber of books, including Understanding Adobe Photo-
shop (Peachpit, 2010), Photoshop for Video (Peachpit, 
2010), and Video Made on a Mac (Peachpit, 2009). 
You can contact Rich at:

›› www.linkedin.com/in/richardharrington

›› www.rhedpixel.com

›› www.richardharringtonblog.com

›› www.3exposure.com

›› www.twitter.com/rhedpixel

Abba Shapiro

Abba Shapiro is a lead instructor 
for Apple’s Pro Video Apps certified 
training program, certifying other 
instructors since the program’s 
inception. He is also co-author 
of the advanced editing tips and 

tricks book, Final Cut Studio on the Spot (Focal Press, 
2007), with Richard Harrington and Robbie Carman.

Abba is an award-winning writer/producer/director 
with over 25 years experience in video and film pro-
duction. He has done work for a wide range of com-
mercial, corporate, and federal clients, including USA 
Today, The Associated Press, NASA, Univision, and the 
Department of Defense.

In addition to production, Abba has been teaching in 
the Washington, D.C. area and around the planet since 
the mid 1980s. He teaches a variety of broadcast edit-
ing tools, scriptwriting, Photoshop for video, and pro-
ducing and production workshops at venues such as 
NAB, IBC, Macworld, Government Video Expo, and New 
York Post Production World. You can contact Abba at:

›› www.shapirovideo.com

›› www.linkedin.com/pub/
abba-shapiro/1/264/964

www.rhedpixel.com
www.linkedin.com/in/richardharrington
www.rhedpixel.com
www.richardharringtonblog.com
www.3exposure.com
www.twitter.com/rhedpixel
www.shapirovideo.com
www.linkedin.com/pub/abba-shapiro/1/264/964
www.linkedin.com/pub/abba-shapiro/1/264/964
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Media in 2006 and began photographing weddings in 
the Washington, D.C. area and beyond. In 2008 she 
became a member of The Professional Photographers 
of America. Recently, Lisa’s work has earned SoftBox 
Media the Bride’s Choice Award 2010 from Wedding-
Wire.com and TheKnot.com’s Best of Weddings 2010 
pick for photography in the D.C. metro area.

Music
We are grateful to Aaron Wold and the band Minimus 
the Poet for sharing their music and story with us. 
Please explore the band’s website to hear more of 
their music.

Minimus the Poet

Minimus the Poet began as 
a solo project. The brainchild 
of Aaron Wold, a Baltimore 
transplant, has blossomed 
into an indie/folk quintet, and 
the band is making its mark 
on the Charm City scene.

Wold composed, performed, 
recorded, and produced the 
album E S O, which was 
released independently in 

2009. The album received high praise from local 
media, and a small cult following began to develop. 
Due to increasing demand for live performances from 

Robbie Carman

Robbie Carman is a professional 
colorist who works on broadcast 
television series and independent 
films. He’s part of the first gener-
ation of certified Apple Final Cut 
Pro instructors and Color. Rob-

bie co-wrote Final Cut Pro Workflows (Focal Press, 
2007) with Jason Osder as well as Final Cut Studio 
on the Spot (Focal Press, 2007) and Video Made on 
a Mac (Peachpit, 2009) with Richard Harrington and 
Abba Shapiro. Robbie speaks internationally at con-
ferences, such as the National Association of Broad-
casters (NAB) and the International Broadcasting 
Convention (IBC). Robbie is the co-owner of Amigo 
Media (www.amigomediallc.com), a boutique postpro-
duction company located in Washington, D.C. You can 
contact Robbie at:

›› www.linkedin.com/in/robbiecarman

›› www.amigomediallc.com

›› www.robbiecarman.net

›› www.twitter.com/robbiecarman

Documentary Photographer
Although there are many photos in the book, we had 
one principal photographer who helped us document 
the experience.

Lisa Robinson

Lisa Robinson began her studies 
of photography in 1999 and imme-
diately knew it would be a lifelong 
career. She began work as a print 
technician for Kodak and took any 
assistant jobs available while com-

pleting college. In 2005 she graduated Magna Cum 
Laude in Applied Media Arts & Photography from Edin-
boro University and started work with Apple, Inc. Her 
work with Apple put her in touch with the vast array 
of technology associated with digital photography and 
further cultivated her passion for beautiful images. 
Together with Ian Robinson, she founded SoftBox 

www.amigomediallc.com
www.linkedin.com/in/robbiecarman
www.amigomediallc.com
www.robbiecarman.net
www.twitter.com/robbiecarman
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the fan base, Wold recruited some of the area’s most 
talented musicians to lend their skills, and they took to 
the stage. Since their first live, full-band appearance, 
Minimus the Poet has performed at nearly every major 
venue in the Baltimore area, branching out into West-
ern Maryland, Pennsylvania, and surrounding cities. In 
2010, a sophomore release followed, titled Married in 
the Mud. The EP features five original tracks co-written 
and performed by the band.

Minimus the Poet has been described as “folk rock,” 
and “experimental folk,” mostly in response to the 
wide range of instrumentation evident on its record-
ings and performances. David Engwall rotates from 
banjo to mandolin to electric guitar. Melissa Thompson 
plays piano, accordion, and percussion. Matt Flanders 
plays bass and percussion. Wold plays both acoustic 
and electric guitar, and—most notably—the theremin. 
A wide range of percussive instruments and vocals 
garnish nearly every song in the band’s repertoire.

Wold cites a wide range of musical artists as being 
influential—everything from 90s rock, including Gin 
Blossoms, Silverchair, and Radiohead, to contem-
porary bluegrass artists like Chris Thile. He is also 
inspired by classical thereminists, such as Clara Rock-
more and iconic country artists Patsy Cline and Elvis 
Presley, and can be quoted saying, “It took a heavy 
dose of punk rock to get over my stage fright. I sup-
pose I have Bad Religion to thank for that.”

Minimus the Poet is currently working on a third stu-
dio release. Visit www.minimusthepoet.com for more 
music, videos, and information.

www.minimusthepoet.com
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About the 
Lesson Files
In your hands is a book, but there are files that accom-
pany these lessons. Here’s how to download them.

1.	 Visit www.peachpit.com/register to register your 
book.

2.	 Log in or create a new account at Peachpit.com.

3.	 Enter this book’s ISBN number: 0321811259.

4.	 You will be given access to this book’s download 
files.

You’ll find different items included in the download:

›› The actual footage shot in this project

›› A video overview of Final Cut Pro X

›› Additional resources on color correction and 
grading

What You Need
Welcome to a high-tech world. You won’t need the lat-
est and greatest, but we do have some strong recom-
mendations. To complete the exercises in this book, 
you’ll need:

›› Mac computer with an Intel Core 2 Duo proces-
sor or better.

›› Final Cut Pro X (Compressor also recommend).

›› 2 GB of RAM (4 GB of RAM recommended).

›› OpenCL-capable graphics card. 

›› 256 MB of VRAM.

›› Display with 1280x768 resolution or higher.

›› OS X v10.6.8 or later.

›› A high-speed hard drive with a FireWire or SATA 
connection for editing video files. Internal laptop 
or computer drives can work, but a performance 
drive (RAID) is highly recommended.

http://www.peachpit.com/register
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chapter 4

Organizing 
Your Media

The act of video editing is not really 

about learning which buttons to push. The hardest part of editing 

is learning how to cull through large amounts of footage to find 

the “good parts”—the best sound bites, the most expressive b-roll, 

and the shots that just work. Of course, you then have to figure 

out how to put all of those pieces together.

In a sense, the act of editing video is much like having ten differ-

ent jigsaw pieces mixed together. You have to find the right pieces 

and figure out how they go together while ignoring the pieces you 

don’t need.

Let’s just say that getting organized will be a critical step in your 

journey to a compelling story. Fortunately, Final Cut Pro X has sev-

eral tools that let you sort, sift, filter, and find the perfect shot. You 

can use embedded metadata as well as attach powerful keywords 

to improve your ability to locate the perfect shot.

In this chapter we’ll explore the many ways to organize your media. 

Although you may want to skip ahead, we encourage you to tough 

it out. Learning how to organize an edit will make the whole pro-

cess run faster and ensures that you’ll have the best shots at your 

fingertips.
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You need to find a level of comfort with events, decid-
ing how big you want each event to be and how broad 
a range each event should cover. For example, for the 
project we’re using in this book, we’re using a single, 
dedicated drive for the project, and footage will be 
grouped into three events: Concert, Interview, and B-roll.

As you work with events, it’s important to use the 
many organizational tools offered by Final Cut Pro X. 
You can access all of the sort methods by clicking 
the Action menu (just look for the gear icon below 
the Event Library):

›› Sort events by date. If you’re working on a proj-
ect that has many shooting days, sorting by date 
can be useful. Just click the Action menu and 
choose Group Events by Date. You can sort by 
Year, Year and Month, or choose not to group. 

Examining Events
After you’ve imported media into events, you’ll want 
to explore the content at your fingertips. Any video, 
audio, or still images that you’ve imported will appear 
as clips in one or more events.

Final Cut Pro X is very literal when it comes to your 
media inside an event. Each event in the Event Library 
has a matching folder on your hard drive. Inside each 
folder is the actual imported media (or an alias that 
points to the original file). 

Sorting Events
As you import your media, you’ll likely end up with mul-
tiple events. As you learned in Chapter 3, "Importing 
and Transcoding Your Media," it is common practice 
to organize events by factors like shoot date, client, 
or topic. Hiding Events

There are also many ways that you can 
choose to hide old or nongermane events in 

the Event Library. For example, you can unmount the 
drive that holds the media or move the event out of the 
Movies folder on your drive. We’ll fully explore these 
workflows in Chapter 11, "Outputting and Managing Your 
Project."

Why Are My Events in 1969?
It’s very easy to have an incorrect creation 
date. Perhaps you didn’t set the time on your 

camera or audio recorder when you changed batter-
ies. Perhaps the clock was wrong on your computer. If 
you have one clip in your event with a different creation 
date, the event will automatically sort itself based on the 
oldest asset. For this reason we recommend not sort-
ing events by date because it isn’t always accurate. We 
choose either the Don’t Group Events by Date option or 
Show Event Date Ranges for greater accuracy. 

Change the Creation Date
A useful application for adjusting creation 
dates is A Better Finder Attributes from  

www.publicspace.net. Because this kind of tool alters 
the media files, it is best to use it before importing into 
Final Cut Pro. Clicking the Action menu (which is shaped like a gear) gives 

you access to several different sorting methods for events.

www.publicspace.net
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2.	 Drag the duration slider to adjust the number of 
frames shown for each clip’s thumbnail in the 
Event Browser. You can also press Shift+Z to 
zoom to fit each clip to a single thumbnail. Usu-
ally, setting the duration to 5–10 seconds works 
well. But your mileage may vary depending on 
the type of footage and length of shots you are 
working with.

3.	 If you want to adjust what’s shown in each 
thumbnail, click the Clip Appearance button at 
the bottom-right corner of the Event Browser. You 
can adjust the height of the clip as well as dis-
able the audio waveform.

›› Sort events by storage location. Many choose 
to isolate clients or projects by hard drive. If 
you’re using multiple disks or partitions, sorting 
by location is a good idea. Just click the Action 
menu and choose Group Events by Disk. This 
option can be combined with any of the date 
sorting options.

›› Show event date ranges. If you want to see the 
full range of dates an event contains, you can 
choose Show Date Ranges in Event Library from 
the Action menu. This can help you easily find 
footage within events by date.

›› Sort events by most recent. If you want to see 
the newest footage first, choose Arrange Events 
by Most Recent from the Action menu.

Viewing Events as a Filmstrip
If you are visually oriented, you’ll find the Filmstrip view 
very useful. By displaying the event as a filmstrip, you 
can see several frames that represent the contents 
of your footage. For many, this is the easiest way to 
visually browse media (especially because clips from 
DSLR cameras lack descriptive names).

1.	 If a List view is shown, click the “Show clips in 
filmstrip view” button near the bottom of the 
Event Browser.

 There are several ways to sort 
events. From left to right, Group 
Events by Disk, Group Events by 
Year, and Group Events by Month 
and Year.
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4.	 To sort a column, click its heading. 

You can click a second time to toggle between 
ascending and descending sort order.

5.	 To view a clip’s rating or keywords, just click the 
disclosure triangle to the left of the clip’s name.

Sorting Clips within Events
As you continue to review your events, it’s easy to 
become overwhelmed by all your footage (especially 
with a big project). Fortunately, Final Cut Pro X offers 
several additional ways to refine how your events dis-
play clips. Much like sorting events, you can sort clips 
within an event. It all begins by clicking the Action menu:

›› Group Clips By Category. You can choose Group 
Clips By and select from several methods, 
including Reel, Date, Scene, Duration, File Type, 
and more. You can set the order to Ascending or 
Descending from the same submenu to create 
a hierarchy. We find that grouping by File Type is 
extremely useful because it groups audio, video, 
and graphics separately. 

›› Arrange Clips By Category. You can also 
arrange clips by Name, Take, Duration, and  
Content Created. We find the last method (Con-
tent Created) useful because it sorts clips in 
order of creation. If you’ve manually renamed 
media, the Name option is also useful. Arrange-
ments can also be sorted in Ascending or 
Descending order.

Viewing Events as a List
If you prefer to organize your footage by file details like 
creation date, duration, or keyword, you’ll find the List 
view useful. Although the List view is mostly filled with 
sortable columns, there is a large filmstrip preview at 
the top of the window. This filmstrip allows full access 
to all of the media as well as the ability to use mark-
ers and keyword ranges.

1.	 If a Filmstrip view is shown, click the “Show clips 
in list view” button near the bottom of the Event 
Browser.

2.	 To customize which columns are viewable, 
Control-click on any column heading and choose 
a category option from the menu. 

3.	 To rearrange columns, click a column heading 
and hold. You can then drag a column left or 
right if you prefer a different order.
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Playhead

The playhead indicates your current position within 
a project. The playhead appears as a thin, gray verti-
cal line. Generally, the playhead is static, but you can 
reposition it by clicking in a clip or your Timeline. The 
playhead does move when you click Play to indicate 
progress as a clip or Timeline plays back.

Here are a few tips to control playback:

›› Press the spacebar to start or stop playback.

›› To play a clip from its beginning, press 
Shift+Control+I.

›› To play just a part of a clip, click and drag 
the yellow handles to define a frame range. 
Press the Forward Slash (/) key to play just the 
selected part of the clip. 

›› If you do not select a range, you can still press 
Shift+Forward Slash (/) to play two seconds 
before and after where the playhead is parked.

›› You can use the J-K-L keys to control playback:

›› Press L to play forward.

›› Press J to play backward.

›› Press K to pause the video clip.

›› To double the playback speed, tap L or J 
twice. Tap again for further incremental 
speed changes.

Examining Clips
Now that you have control over sorting your clips, it’s 
time to actually watch your media. The process of 
reviewing or skimming your footage will make it eas-
ier to tag footage with keywords and roles, as well as 
help you find the best shots. 

Taking the time to review your footage and annotate 
it greatly improves your end results. When an event is 
selected in the Event Library, you can view its clips in 
the Event Browser. This is the first step toward view-
ing and organizing your footage.

Viewing Individual Clips
When you’ve located a clip in an event, you have sev-
eral ways to view its contents. It’s important that you 
learn how to use the dynamic preview capabilities of 
Final Cut Pro X to speed up your edit workflow.

There are two primary tools that you’ll use for play-
back and previewing: the playhead and the skimmer.

 The J-K-L keys will quickly 
become an integral part of your 
keyboard controls.

 Grouping by category is a useful way to organize 
your media.

The Best of Both
You can use both a Group and an Arrange 
method to sort clips independent of each 

other. Using these arrangement features makes it much 
easier to find clips.
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Renaming Clips
By default, DSLR media has pretty useless filenames 
(they’re not unique, and it’s very easy to have dupli-
cate filenames). Even if all your files have different 
names, how useful is a name like MVI_04567.mov? 
Fortunately, you can easily rename clips within your 
event. You can rename clips in the Event Browser 
or in the Info inspector anytime you want. Note that 
when you rename a clip in Final Cut Pro X, it does not 
rename the source media file on your disk. Here are 
a few ways you can rename clips:

›› Rename a clip in the Event Browser in Filmstrip 
view. If you’re in Filmstrip view, simply select a 
clip’s name and type a new name.

›› Rename a clip in the Event Browser in List 
view. If you’re in List view, simply select a clip’s 
name, press Return, and then type a new name.

›› Rename a clip in the Info inspector. Select a 
clip in the Info inspector by clicking the Inspector 
button in the toolbar. Click the Info button at the 
top of the pane that appears. You can then click 
in the Name field and type a new name.

Organizing Clips with Roles
When you import clips into Final Cut Pro X, the applica-
tion automatically assigns metadata text labels. These 
labels are based on one of five default roles: Video, 
Titles, Dialogue, Music, or Effects. You can also cre-
ate custom roles and further refine with subroles that 
you can manually assign to clips. For example, you can 
assign the role of Interview to all of your sound bites 
to easily separate them from the rest of your footage.

›› To move the playhead one frame at a time, 
hold down the K key and tap J or L.

›› To move the playhead in slow motion, hold 
down the K key while pressing down J or L.

Want to Think About It?
If you want to keep playing a clip over and 
over again to closely study it, that’s easy. Just 

press Command+L to toggle looping on or off.

Skimmer

Another method for previewing clips is the skimmer. 
Using the skimmer lets you move the mouse to freely 
preview a clip without affecting the playhead position. 
The benefit of the skimmer is that it lets you quickly 
review several frames in a clip by simply moving the 
mouse (all without losing your current position).

The skimmer appears as a thin, pink vertical line as 
you move the pointer across the clip. The skimmer tem-
porarily turns orange if snapping is enabled and the 
skimmer snaps to a position. Snapping makes it easier 
to drag between markers and In points, for example.

The Trouble with Skimming
When it comes to skimming, you’ll either love 
it or hate it, or sometimes both. The good 

news is that you can enable or disable skimming eas-
ily. You can turn off all skimming by pressing S or audio 
skimming only by pressing Shift+S.

Switch from Skim
If you want to play a clip while skimming, just 
press the spacebar. The playhead will jump to 

the skimmer position and start to play.

What a Name Does
When you rename a clip, it only affects the 
one instance of the clip. For example, if you 

copy a clip from one event to another and then rename 
one of the clips, only the modified clip will change. Every 
instance of a clip can have its own name.
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Apple has positioned roles as the primary way to iden-
tify related elements when working in the Timeline and 
when exchanging data with an XML file. Roles should 
continue to play a more important part as Final Cut 
Pro X continues to evolve and share media with other 
applications.

Setting Up Roles

A good place to start to set up roles is to open the 
Roles Editor. Choose Modify > Edit Roles to see the 
current roles and subroles you’ve set up. Roles are 
globally defined for the application, so you cannot have 
different roles for different projects.

To create a new role, follow these steps.

1.	 To add a new role, click the Assign New Role 
button at the bottom-left corner of the Role 
Editor window.

2.	 Choose to add a New Video Role or New Audio 
Role.

3.	 Click on the new role and enter a new name.

You can also add subroles to further refine a role cat-
egory. For example, you can split the Video role into 
smaller categories like b-roll, behind the scenes, reen-
actment, and so on to make it easier to categorize 
your footage. Creating subroles is easy.

1.	 Click a role to select it.

2.	 Click the Subrole button at the bottom center of 
the panel.

3.	 Click on the new subrole and enter a new name.

The Rules

Keep in mind that there are a few rules when it comes 
to using roles:

›› Every clip must have at least one assigned role.

›› If a clip has audio and video, it will always have 
one audio and one video role.

›› You cannot assign a video role to audio-only 
clips or an audio role to video-only clips.

›› Roles cannot be assigned to a clip range or a 
portion of a clip.

›› You can assign different roles to each instance 
of a clip. For example, a clip in the Timeline can 
have a different role assigned in an event.

›› To delete a subrole or a custom role, just click 
to select it and press the Delete key. You cannot 
delete the original five roles, however. You’ll also 
need to make sure that no clips are assigned to 
a subrole in your events. Once cleared, the role 
or subrole will no longer appear as an option 
when you relaunch the application.

Assigning Roles

You can assign roles to clips at any point in your edit-
ing. In fact, you can assign a role in the Event Browser, 
the Info inspector, the Modify menu, or the Timeline 
Index. Here’s how:
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›› Use keyboard shortcuts. If you want to assign 
roles using the keyboard, that’s possible too: 

›› Video (Control+Option+V)

›› Titles (Control+Option+T)

›› Dialogue (Control+Option+D)

›› Music (Control+Option+M)

›› Effects (Control+Option+E)

›› View and reassign roles in the Timeline Index. 
After you’ve added clips to a Timeline, you can 
assign roles. This function is often used to 
help assign track-based output for files (such 
as when going to tape). You can also use roles 
to help you isolate clip types in your Timeline 
(even making entire roles invisible by deselect-
ing them). 

›› Open the Timeline Index by pressing 
Command+Shift+2. View your clips in use by 
clicking the Clips pane at the top of the Time-
line index. Use the Roles column to add roles to 
your clips (if it’s not visible, just Control-click on 
the heading and choose Roles from the menu). 
You can then click on a role and add or edit 
assigned roles.

Managing Your 
Event Library
Now that you understand the value of events as an 
organizational tool, it’s important to know how to 
manage your Event Library. There are several ways to 
merge, split, and rename events.

Merging Events
If you end up with too many events, you can quickly 
merge two or more events into a single event. This 
makes sense if you have two events with media that 
is closely related (such as by client or topic).

›› View and reassign roles in the Event Browser. 
With one or more clips selected in the Event 
Bowser, you can use the Roles column. Make 
sure you are in List view and that you can see 
the Roles column (if it’s not visible, Control-
click a column head and choose Roles). You can 
then click the assigned role for a clip to see a 
shortcut menu listing the available roles. Simply 
choose additional roles that you want to assign.

›› View and reassign roles in the Info inspector. 
With one or more clips selected in the Event 
Bowser or Timeline, you can use the Info inspec-
tor. If it’s not visible, click the Inspector button 
in the toolbar and click the Info button at the top 
of the pane that appears. You can click in the 
Roles field to choose from available roles.

›› If the Roles metadata is not visible, click the 
View button at the bottom of the pane and 
choose Edit Metadata View. You can then use 
the search field and enter roles. Select the 
Roles field to add it to your view.

›› View and reassign roles in the Modify menu. 
An easy way to assign roles is to use the Mod-
ify menu. With a clip selected, simply choose 
Modify > Assign Roles, and choose a role from 
the submenu. Once selected, a check mark 
appears next to the roles in use.
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Moving Media Between Events
When you want to take a clip from one event and put 
it in another, you can choose to move it. This means 
that the file will actually be removed from one folder 
on your disk and relocated to another. To move a clip:

›› If the event is on the same disk, simply drag 
from one event to another. 

›› If the events are on different disks, hold down 
the Command key when you drag. 

You’ll know that a move is occurring if no symbol 
appears next to the clip’s name when dragging. It’s 
important to note that this actually moves the clip from 
one drive to another at the Finder level. This could be 
dangerous if you are sharing media.

What’s the Wait?
Keep in mind that when you copy or move 
media, files are actually transferring in the 

background. If you are managing a lot of media, it can 
take a few minutes to complete the task of copying or 
moving the source files from disk to disk.

There are two ways to merge events:

›› You can select multiple events that you want to 
combine, and choose File > Merge Events. In 
the Merge Events window, give the event a new 
name, choose a disk where you want to store 
the event’s source media files from the Location 
menu, and click OK.

›› You can create and name a new event, and then 
drag one or more existing events into the new 
(empty) event.

Splitting Events
If you find that an event is getting too big to manage, 
you can split it into two events. There are two strate-
gies you can employ to make this task simple:

›› You can create a new event and drag the media 
from its current event into a new event. The orig-
inal media files (or aliases) on your disk will be 
moved into the new Events folder.

›› You can choose to create a duplicate event and 
modify it by highlighting the desired event and 
choosing File > Duplicate Event. You can then 
go through the event and delete any unwanted 
clips. Simply select an unwanted clip (or clips) 
and press Command+Delete to remove it from 
the event and your disk. Be careful not to just 
press Delete (which seems natural): Instead of 
removing a clip, you will just mark the clip as 
“Rejected.”

Copying Media Between Events
When you want to have a clip appear in two events, 
you can copy it. This will place a version of the clip 
in both events, which means that files are duplicated 
on disk. To copy the clip:

›› If the event is on the same disk, hold down the 
Option key when dragging. 

›› If the events are on different disks, simply drag. 

You’ll know that a copy is occurring if a green circle 
with a plus symbol appears next to the clip’s name 
when dragging.

 The plus symbol  
indicates a copy com-
mand is in progress.

 The lack of a plus symbol (number of files is in a red circle) 
indicates that a Move command has been invoked.
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of an editing session (especially if the client is in the 
room). Marking favorites gives you a quick way to iso-
late your best footage.

1.	 In the Event Browser, select a clip, or multiple 
clips, you want to rate.

You can also use the Select tool to choose a 
range (part) of a clip. This is similar to the pro-
cess of creating a subclip.

2.	 Press F or click the Favorite button in the toolbar. 

A green line appears at the top of the frames 
you’ve marked as Favorite in the Event Browser.

You’re Not My Friend Anymore
If you change your mind about a Favorite 
ranking, that’s easy to amend. Just press the 

U key (for un-favorite) or click the Remove Ratings from 
the Selection button in the toolbar. To quickly reselect 
just the range, click the green bar or red bar.

Rating Clips
Now that you’ve figured out how to browse your events 
and organize your content, it’s time to start making 
decisions. You need to rate your clips so you know 
which ones you want to use and which ones you 
should ignore. Final Cut Pro X has a three-choice sys-
tem of ratings. 

›› All clips come in at a neutral state. 

›› You can then mark your favorite clips (or star 
them) to be sure to use them. 

›› You can also reject a clip and hide it to avoid 
using footage that is subpar.

Marking Favorite Clips
As you review your footage, you’ll want to take the 
time to mark the best shots you want to use, making 
it easier to find those shots while you’re in the middle 

 The green bars indi-
cate regions that have 
been marked as favor-
ites. The red bar shows 
a clip that has been 
rejected.

 By making a selec-
tion and pressing the F 
key, you can mark that 
selection as a favorite 
for quick reference later.
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What About Subclipping?
In many editing programs you can mark an 
area of a longer clip and save it as a sub-

clip. This is often used in a long interview to split the 
response to each question into separate clips that are 
easier to organize. In Final Cut Pro X you can use the 
Select tool to choose a range inside a clip (by dragging). 
A range can then be marked as a favorite. Select the 
favorite in your event and press Return to edit its name. 
You can also use the Notes column to tag the favorite 
with additional details to help you when editing.

Rejecting Clips
Just as you mark your best clips, you should also take 
the time to reject those shots you want to avoid. The 
Rejected rating should be used for shots that contain 
soft focus, bad performance, or garbled audio.

 Remember that Delete rejects a clip, whereas 
Command+Delete throws it in the trash (these are the 
same shortcuts used in the Finder).

1.	 In the Event Browser, select a clip, or multiple 
clips, you want to rate.

You can also use the Select tool to choose a 
range (part) of a clip.

2.	 Press Delete or click the Rejected button in the 
toolbar. 

A red line appears at the top of the frames 
you’ve marked as Rejected in the Event Browser.

Removing Ratings
If you want to remove the rating from a clip, it’s pretty 
simple. At the top-left corner of the Event Browser, 
click the Filter menu and choose the All Clips option 
to ensure that you are seeing all of your footage. You 
can then press U or click the Clear Rating button in 
the toolbar. This removes the green or red line at the 
top of the clips in the Event Browser.

Filtering Clips 
Ratings are very useful for several tasks. You can use 
the Filter menu in the Event Library or corresponding 
keyboard shortcuts to adjust your view. This makes 
it easier to edit by removing substandard shots. It’s 
also a great way to clean up an event. 

 The view on the left is the standard icon view of the event in All Clips mode (Control+C). On the right, 
only Favorites are shown (Control+F). 
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Adding Keywords 
to Clips
Another tool at your disposal for organizing media is 
the use of keywords. You can use two types of key-
words when working in Final Cut Pro X: 

›› Analysis keywords. Final Cut Pro X can auto-
matically generate keywords when you analyze 
clips for common problems. This can be done on 
import or after the fact when you select clips in 
an event and choose Modify > Analyze and Fix.

›› Manually added keywords. You can also review 
clips and choose to add keywords of your own 
design. This is a great way to get organized 
based on repeating themes or logical groupings.

Need More Details?
Keywords are very useful, but sometimes 
you’ll want more details. When working in 

List view for an event, you’ll find a Notes column. Here 
you can add detailed information about a clip. Notes can 
also be assigned to any Keyword or Favorite ranges by 
clicking the disclosure triangle and then clicking in the 
Notes column for each item.

Assigning Keywords
Adding keywords is a very straightforward process (and 
one that will seem familiar if you use iPhoto or Aper-
ture). Make sure you either watch your footage play-
back in real time or use the skimmer to quickly browse.

1.	 In the Event Browser, make a selection. You can 
choose a range, an entire clip, or multiple clips 
that you want to add keywords to.

2.	 Click the Keywords button in the toolbar to open 
the Keyword Editor.

Here are a few ways to get organized using the Filter 
menu:

›› You can choose to display just the clips that are 
marked as Favorites by pressing Control+F.

›› If you want to hide the Rejected clips, press 
Control+H.

›› If you need to free up disk space, press 
Control+Delete to see only your Rejected clips. 
You can then select this media and press 
Command+Delete to remove it from the event 
and your hard drive. For more information, see 
“Deleting Footage” at the end of this chapter. 
Just be careful; if a media file contains both 
Favorite and Rejected ranges, all the media is 
discarded with this method.

 The purple keywords are generated by Final Cut 
Pro X when you analyze imported media. The blue  
keywords were added on import or using the Keyword 
Editor.
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Here’s how to use keyword shortcuts.

1.	 If it’s not already open, click the Keywords but-
ton in the toolbar to open the Keyword Editor.

2.	 If the shortcuts aren’t visible, click the disclo-
sure triangle to the left of Keyword Shortcuts in 
the Keyword Editor.

3.	 Click in a field next to a shortcut (1–9) and enter 
a phrase or keyword in a shortcut field. Press 
Return to capture the change.

4.	 To use a keyword shortcut, select a range or one 
or more clips that you want to modify.

5.	 Press Control and the corresponding number key 
(1 through 9) to assign a keyword or keyword 
phrase.

Removing Keywords
If you need to remove a keyword, you can do so in 
two ways. You can remove individual keywords or all 
keywords:

›› Remove individual keywords. If you need to 
delete a keyword from a clip, just select it and 
open the Keyword Editor. You can then select 
and delete any keywords in the top field to 
adjust the clip or selection.

3.	 Enter a word or phrase that you want to use 
as a keyword for the selected clip(s) and press 
Return.

4.	 Continue adding keywords or keyword phrases 
as needed.

A blue line appears at the top of the selection in 
the Event Browser, which indicates that keywords 
are in use for the clip or range.

5.	 When you’re finished adding keywords, simply 
close the Keyword Editor.

As you continue to add keywords to your clips, you’ll 
see more Keyword Collections appear in the Event 
Library. A Keyword Collection is essentially a group of 
pointers (aliases) to clips that you have tagged with 
a specific keyword.

Using Keyword Shortcuts
Another quick way to add keywords or keyword phrases 
is to use keyboard shortcuts. You can have up to 
nine shortcuts loaded globally (not per event). How-
ever, removing a shortcut does not affect clips you’ve 
already tagged. You can freely adjust your shortcut keys 
without affecting your previously processed footage.

 Keywords were automatically added because the Import 
Folders as Keyword Collections option was selected. In this 
case a few clips were tagged incorrectly because the Direc-
tor of Photography had footage from two days of shooting on 
one card.

Multiple Keywords
You can add multiple keywords to a shortcut 
register. Just press Tab and enter the new 

keyword. The shortcut will then apply multiple keywords 
with a single click.
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 You can select 
unwanted keywords 
in the Keyword Editor 
and press Delete to 
remove them.

›› Remove all keywords from a clip. In the Event 
Browser, select one or more clips. Then choose 
Mark > Remove All Keywords (Control+0).

Filtering Clips
Now that you’ve taken the time to organize your foot-
age into events, apply keywords and ratings, and ana-
lyze your footage, you have a lot of information to work 
with. Learning how to use the Filter commands will 
give you greater control while editing.

Search for Clips By Clip 
Names and Notes
Located at the top of the Events Library is the search 
field. This is a useful way to search for clips by name 
or by any notes you’ve added. Simply select one or 

more events you want to search in the Event Library 
(Command-click for multiple events). Then in the 
search field enter a text string you want to search 
for. To remove a search, just click the small x at the 
right of the field.

Search for Clips By a 
Combination of Criteria
Although the search field is convenient, using a com-
bination of criteria lets you quickly find the clips you’re 
looking for. You can use multiple criteria to search with 
the Filter window. Categories include clip name, rat-
ing, media type, excessive shake, keywords, the pres-
ence of people, format information, date, and role. 

1.	 In the Event Library, select the event or folder 
you want to search.

2.	 Click the Filter button at the top-right corner of 
the Event Browser.

 Use the Search 
field (in the upper-
right corner of the 
browser) to search 
the Name and Notes 
columns.
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3.	 In the Filter window, select search criteria, or 
rules. You can add additional rules using the 
Add Rule menu:

›› Text. Find clips by their name or search any 
notes applied to them in List view.

›› Ratings. Find clips based on the rating 
assigned.

›› Media Type. Search for clips whose source 
media files are of a specific type (video, 
audio, or stills).

›› Stabilization. Hide or show video clips that 
Final Cut Pro has identified as having exces-
sive shake.

›› Keywords. Search for one or more keywords.

›› People. Find clips that Final Cut Pro X has 
identified as having people in them if you 
analyzed your clips.

›› Format Info. Search by frame rate, reel, take, 
scene number, and other criteria.

›› Date. Search by creation or import date, as 
well as apply logical rules to help specify an 
exact match or a range of dates.

›› Roles. Find clips by their assigned roles. 
Earlier in the section “Organizing Clips with 
Roles,” you learned to assign custom roles 
and subroles, as well as how certain roles 
are automatically added. 

4.	 You can refine a search by applying additional 
rules. You can specify that a search must match 
at least one criterion or that all criteria must be 
met. Just use the menu in the upper-left corner 
and choose All or Any. 

5.	 When you’re done with a search, click the Reset 
button to the right of the search status icons in 
the upper-right corner of the Event Browser.

 By refining the Filter controls, the clips were narrowed down 
to only those that contained the keyword mixer, were marked 
as favorites, and did not have excessive shake.



Using Smart Collections
The powerful search criteria in Final Cut Pro X really let 
you drill down through many clips to find the results 
you need. To make it easier to search, Final Cut Pro X 
lets you save your search results as a new Smart Col-
lection. Clips that appear in Smart Collections are not 
duplicate media. Rather, Smart Collections filters clips 
in an event, which helps you focus on the clips needed 
for a specific task.

Create a Smart Collection Based on 
Search Criteria

To create a Smart Collection, select an event in the 
Event Library to begin.

1.	 Use the Filter window to perform a criteria-based 
search.

2.	 Click the New Smart Collection button in the Filter 
window to add an untitled Smart Collection in the 
Event Library.

3.	T ype to enter a new name for the Smart Collection, 
and press Return.

Whenever you add clips to an event that match the 
Smart Collection’s search criteria, they will be auto-
matically added to the Smart Collection.

Change the Contents of a Smart Collection

After you’ve created a Smart Collection, you can still 
modify it.

1.	 Double-click a Smart Collection whose contents 
you want to change.

2.	I n the Filter window, modify the search criteria.

3.	 Close the Filter window to update the Smart 
Collection.

Delete a Smart Collection

If you decide that you no longer want a Smart Collec-
tion, select it and choose File > Delete Smart Collection 
(or press Command+Delete). This removes the Smart 
Collection from the Event Library but does not delete 
the associated clips.

 By storing a set of filter results as a Smart Collection, you make it easy to find your footage 
while in the midst of future editing sessions.
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Deleting Events
Another option when cleaning up is to delete an entire 
event. This technique should not be used often because 
it is a quick way to clear off several clips that you no 
longer need. Typically, you’ll want to back up or archive 
your media first, however. Be sure to read Chapter 11 
to learn about managing projects and media before 
you start throwing away events or clips.

1.	 Select an event or multiple events in the Event 
Browser for deletion.

2.	 Choose File > Move Event to Trash 
(Command+Delete).

Danger! Danger!
If you move items to the trash and then 
empty the trash, those clips (and all their 

metadata) are gone for good. After you empty the trash, 
the deleted clips or event and all their source media files 
that previously resided in the Final Cut event cannot be 
recovered.

Deleting Footage
As you continue to edit your footage, you may decide 
to delete footage from an event. Unlike previous ver-
sions of Final Cut Pro (and most other nonlinear edit-
ing tools), deleting a clip from an event actual does 
move the source media to your computer’s trash.

Deleting Media 
If you want to remove individual clips, just select them 
in an event. Then choose File > Move to Trash (or 
press Command+Delete). If you’re sure you want to 
permanently get rid of them, switch to the Finder and 
choose Finder > Empty Trash. 

It’s important to note that only media inside events 
will be trashed. If you did not copy the data into the 
event on import, the original media remains on your 
disk. For this reason, we do not select the Copy files 
to Final Cut Event folder option on import. In this work-
flow you’ll delete the aliases that point to the media, 
but your original camera files will remain on disk. This 
workflow works well because the media might be in use 
in another project or another editor may need it (also, 
there’s no danger of trashing your original media files).

If you’re not sure you want to commit to deleting 
media, just reject it, and then choose Hide Rejected. 
You can easily recover rejected clips by removing the 
rating from the clip.



176 index

Index
5.1 surround channel, configuring, 

146
7.1 surround channel, configuring, 

146
24 fps frame rate, 5
25 fps frame rate, 5
30 fps frame rate, 5
50 fps frame rate, 4
60 fps frame rate, 4
720p video formats, 6
1080 video formats, 6
1280 × 720 HD standard, 4
1920 × 1080 HD standard, 4

A
advanced editing commands. See also 

edits; trimming edits
adding audio only, 99
adding video only, 99
deleting ranges, 99–100
isolating clips during editing, 

100–101
Overwrite edit, 96–97
Replace edit, 97–98

All Clips mode, 47
aperture, explained, 7–8
Aperture application

importing footage from, 32
using, 86

Appearance button, using with 
waveforms, 142

Append to End Edit command, 83
Apple applications, sharing with, 

158–159
Apple Compressor, bringing media 

into, 35
Apple devices, transferring to, 

160–161
Apple Mail, using to send video, 161
Apple ProRes options, choosing, 35
archives. See also camera archives

Blu-ray Discs, 21
DVD-ROM, 21

archiving data, 15
audio

adding only, 99
analyzing, 27, 148, 150
collapsing, 142
detaching, 113, 142
dual system sound, 10, 66–67

enhancing, 148, 150, 152–154
internal microphone, 9
mixing, 143–148
monitoring, 9
moving, 89
on-camera microphone, 9
pre-amps, 9
removing silent channels, 27
Reset button, 27

Audio Animation Editor, showing and 
hiding, 150

audio clips. See also clips
matching, 153
muting, 145
resetting, 147
showing expanded, 142
soloing, 144
syncing with video, 67–73
un-matching, 153
viewing, 141–142

audio crossfade, adding, 113
audio effects

applying, 154
resources for, 153
using keyframes with, 154

Audio Enhancements Inspector, 150
Background Noise Removal, 148
Hum Removal, using, 148
Loudness effect, 148

audio fades
creating, 147–148
crossfades, 147
fade handles, 148

audio levels, adjusting, 146
audio meters, using, 143–144
audio modification

Audio Inspector, 147
Modify menu, 147
Timeline, 146–147

audio problems, analyzing and 
fixing, 27

audio properties, defining, 59
audio sync point, spotting, 69
audio waveforms. See waveforms
auditioning music, 149
auditions, grouping clips into, 98
AVCHD 

codec, 7
importing media, 32–34

B
Background Tasks window, 

opening, 25
backing up 

in Finder, 172
projects, 60

backup workflow
archiving data, 15
mounting memory cards, 14
transferring field drives, 14
transferring footage, 14

balance color, analyzing video for, 26
Blu-ray discs

burning to, 166–167
creating archives, 21

burning to disc, 165–167
Blu-ray, 166–167
DVD, 165–166

C
camera archives. See also archives

creating, 30
importing media from, 32–34
Open Archive command, 34
selecting clips in, 33

camera settings
codec, 5, 7
frame rate, 4–6
frame size, 4
resolution, 4

cameras, syncing, 71–73
card readers

bus power, 17
portable, 17
slots, 17
speed, 17

cards. See memory cards
channels, configuring, 145–146
clip analysis, 27
clip items, breaking apart, 146
clip speed, changing, 133–135
clips. See also audio clips; connected 

clips; gap clips; moving clips; 
placeholder clips

analyzing after importing, 116
Arrange method, 41
arranging in Timeline, 82–90
assigning keywords to, 48–49
assigning roles, 43–44
Auto Balance option, 117–118
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auto matching color and look, 
118–119

on computer monitor, 137
exposure, 122
saturation, 123
Shape Masks, 126–127
speeding up, 124

color grading, resource for, 116
Color Masks

combining with Shape Masks, 128
using, 124–126

color theory, resource for, 126
color tint, adding or removing, 124
Command key. See keyboard shortcuts
compound clips, 67
Compressor. See also sharing projects

exporting with, 170
sending projects to, 169

computer. See also portable computer
connectivity, 16
selecting, 15–16

computer monitors, color correction on, 
122

Connect edit, performing, 83–84
connected clips. See also clips

deleting items from Timeline, 100
moving, 87

connectivity, considering, 16
copying

files to Final Cut Events folder, 24
markers, 110
project files, 172

corrections. See also color correction
cropping footage, 130–131
rolling shutter, 129
saving presets, 123
stabilizing footage, 129

COW forums, 175
cropping footage, 130–131
cross dissolve, adding, 112
crossfades, adding, 147

D
date, searching for clips by, 51
deleting

clips from Timeline, 99
events, 53
footage, 53
keywords, 31, 49–50
media, 53
projects, 63
ranges from Timeline, 99
render files, 172–173
transitions, 113
video properties, 59

Dialogue role, 42, 44
disc, burning to, 165–167
disk images

benefits, 18
creating on portable drives, 

18–19
file protection, 18
file size, 19
importing data, 31
remounting memory cards, 18
using, 31

Disk Utility application, accessing, 18
dragging clips, 87
drives, dragging between, 60. See 

also portable drives
drop frame timecode, 58. See also 

timecode
DSLR syncing, 11
DSS (dual system sound), 10, 66–67
DualEyes, syncing footage with, 75
Duration slider, adjusting, 78, 80
DVD

burning to, 165–166
creating archives, 21

E
edit points, nudging with keyboard, 

103
edit types, 82

Append to Edit, 83
Connect edit, 83–84
Insert edit, 83

editing drive
connectivity, 20
RAID, 20
speed, 20
transferring media to, 21

edits. See also advanced editing 
commands; Overwrite edits; 
trimming edits

adjusting timing of, 102
trimming, 101–108

Effects Browser, filtering effects in, 
154

effects role, 42, 44
email, attaching movie files to, 161
equalization

adjusting, 152
matching audio clips, 153

Event Browser
reassigning roles in, 44
selecting ranges in, 81
using, 92
using markers in, 109
viewing roles in, 44

Event folder, contents of, 28, 171. 
See also folders

changing timing between, 
103–104

connecting to projects, 82
deleting from Timeline, 99–100
disabling groups of, 100–101
displaying timecode for, 80, 88
extending lengths of, 102–103
filtering, 47–48, 50–51
Group method, 41
grouping into auditions, 98
inserting into projects, 82
isolating during editing, 100–101
lengthening, 104
managing in events, 28
marking favorites and rating, 

46-48
nudging with keyboard shortcuts, 

88–89
overwriting, 96–97
overwriting with Position tool, 

89–90
playhead, 41–42
playing from beginning, 41
previewing, 41–42
rejecting, 47
removing, 82–85, 99
removing ratings, 47
renaming, 42
replacing, 97–98
reversing, 136
searching for, 50–51
selecting, 33, 80
shortening, 104
skimmer, 42
soloing, 100
sorting within events, 40–41
subclipping, 47
synchronization order, 68
syncing automatically, 67–68
trimming start and end of, 104, 

106
viewing, 41, 69, 78
zooming in, 69

codecs, 5, 7
AVCHD, 7
H.264, 7
Motion JPEG, 7

color, adjusting, 124
color board

accessing, 122
areas of, 122
moving selected controls, 122

color correction, 120–128. See also 
corrections

Analyze for Balance Color, 117
analyzing clips, 116–117
auto balancing color, 117–118
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I
image editing applications, using, 86
Image Products website, 18
images, accessing, 92. See also still 

images
import methods

Aperture, 29
camera archive, 20–30
direct connect, 29
iPhoto, 29
removable media, 29

Import Preferences
analyzing audio, 27
analyzing video, 26
graphic conversion, 26
organizing, 24
transcoding, 25, 35

importing media
Aperture, 32
AVCHD, 32–34
camera archives, 32–34
digital files, 30
hard drives, 30–31
iPhoto, 32
memory cards, 30–31

In and Out points, adjusting with Slip 
edit, 106–107

Info Inspector
reassigning roles in, 44
viewing roles in, 44

Insert edit, performing, 83
Inspector, checking footage in, 58
interlaced scanning, 6
interviews, syncing automatically, 

70–71
iPhoto

importing footage from, 32
using, 86

ISO settings, 7–8
iTunes, sending projects to, 160–161

K
Ken Burns crop, described, 131
keyboard shortcuts

All Clips mode, 47
Background Tasks window, 25
Balance Color, 118
Collapse Audio/Video, 142
Color area on color board, 122
cross dissolve, 112
Disk Utility application, 18
Export Media, 167
Exposure area on color board, 

122
Favorites, 47
gap clips, 84

filters, making selections with, 81
Final Cut Events folder, copying files 

to, 24
Final Cut Pro, 7 versus X, 57
Finder, backing up in, 172
finding people, analyzing video for, 26
folders. See also Event folder

importing as Keyword  
Collections, 24

organizing Project Library with, 61
footage. See also synced footage

appearance of, 116
backing up, 21
checking in Inspector, 58
cropping, 130–131
deleting, 53
importing, 32
offloading, 18
retiming, 133–134, 136
stabilizing, 129
transferring to field drives, 14

formats, mixing in Timeline, 131–133
frame rates, 4–6

24 fps, 5
25 fps, 5
30 fps, 5
50 fps, 4
60 fps, 4
avoiding mixing, 5, 57
choosing, 5
conforming, 132–133
considering, 57
displaying, 5
getting details about, 58

frame size, 4
conforming, 131–132
considering, 57
getting details about, 58

freeze frames, creating, 136
From Still to Motion page, 175

G
gap clips, using, 84–85. See also 

clips
graphic conversion, 26
graphics card, upgrading, 25

H
H.264 codec, 7
hard drives, importing media from, 

30–31
HD standards, 4
Histogram, using, 121
hold frames, creating, 136
Hum Removal, using, 148

Event Library, managing, 44–45
events

best practices, 28
changing creation date, 38
copying media between, 45
creating, 29
deleting, 53
grouping, 28
hiding, 38
managing clips in, 28
merging, 44–45
moving media between, 45
naming, 28
organizing, 28
renaming, 29
showing date ranges, 39
sorting, 38–41
splitting, 45
viewing as filmstrips, 39
viewing as lists, 40

Export Media option, accessing, 164
exporting

audio-only files, 168
with Compressor, 169–170
master files, 170
movie files, 164, 167–168
still images, 168–169
using Compressor settings, 170

exposure, adjusting, 122
exposure triangle

aperture, 7–8
ISO, 7–8
shutter speed, 7–8

F
Facebook, publishing projects to, 

163–164
fade handles, using with audio  

fades, 148
favorites

making selections with, 81
marking and unmarking, 46

Favorites keyboard shortcut, 47
field drives, transferring to media 

storage, 14
files. See also project files

importing, 30
storage of, 171

Filmstrip view
displaying clips in, 69
displaying events in, 39
working in, 78–80

filmstrips
displaying detail in, 78
shortcuts, 80
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N
narration, recording, 151
native editing, support for, 25

O
optimized media, choosing, 35
Option key. See keyboard shortcuts
Other World Computing website, 16
Out point. See In and Out points
Overwrite edits. See also edits

controlling order of clips, 97
performing, 89–90, 96–97
starting point for clips, 97

P
photo editing applications, using, 86
photos. See also still images

accessing, 92
color correcting, 86
enhancing, 86

Photos Browser, using, 92
placeholder clips, using, 85. See also 

clips
playback, controlling, 41–42
playhead

displaying current position in, 
41–42

trimming end of clips at, 104, 
106

trimming start of clips at, 104, 
106

portable computer, selecting, 15–16. 
See also computer

portable drives. See also drives
bus power, 16
connectivity, 16
creating disk images on, 18–19
offloading cards to, 17–18
speed, 16
SSDs (Solid State Drives), 16

Position tool
overwriting clips with, 89–90
switching to, 90

pre-amps
AGC (Automatic Gain Control), 9
phantom power, 9

Precision Editor
activating, 107
Ripple edits, 107
Roll edits, 107
using, 142

primary storyline, 83
moving clips from, 88
moving clips to, 88

progressive scanning, 6

master files, exporting, 170
media

consolidating for projects, 174–175
deleting, 53
importing, 30–31
transferring, 15–19, 21

Media Browser
opening, 159
sending projects to, 158–159
using, 32

media files, moving or duplicating, 
173–174

megapixel counts, 4
memory cards

importing media from, 30–31
mounting on portable machines, 14
SDHC Class 10, 15
speed, 15
UDMA, 15

merging events, 44–45
metadata

creating and utilizing, 26
text labels, 42

microphone
internal, 9
on-camera, 9
quality, 9

Modify menu
reassigning roles in, 44
viewing roles in, 44

monitors, color correction on, 137
mono channel

configuring, 145
separating, 27

Motion JPEG codec, 7
move operations, undoing, 87
movie files

attaching to email, 161
burning to disc, 165–167
exporting, 164, 167–168

moving audio, 89
moving clips, 88. See also clips

dragging horizontally, 86
dragging vertically, 87
entering timecode values, 88
with keyboard nudging, 89
with numerical entry, 89
to primary storyline, 88
from primary storyline, 88
to primary storyline, 88
in Timeline, 107–108

music, auditioning, 149
Music and Sound Browser, using, 140
Music role, 42, 44

importing files, 30
Match Color, 118
moving audio, 89
nudging clips with, 88–89
nudging edits, 103
placeholder clips, 85
playback, 41
Replace edits, 97–98
Ripple edit, 102–103
roles, 44
Roll edit, 104
Saturation area on color board, 

122
Slide edit, 107
Slip edit, 106
Solo, 144
soloing clips, 100
Synchronize Clips, 68–69, 71
timecode, 80
Timeline Index, 44
Timeline navigation, 90
undoing moves, 87
Video Scopes, 119

keyframes, using with audio effects, 
154

Keyword Collections, importing folders 
as, 24

keywords
added manually, 48
analysis, 48
assigning to clips, 48–49
deleting unwanted, 31
multiple, 49
removing, 49–50
searching for clips by, 51
shortcuts, 49

L
library, organizing, 24
List view, 78
Logic Effects reference guide, 153

M
Mac OSX Audio Effects reference, 153
magnification, increasing, 87
markers

adding, 109
copying and pasting, 110
features, 108
jumping between, 109
modifying, 109–110
nudging, 110
removing, 109
syncing with, 69
using in Event Browser, 109
using remote with, 167
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Shape Masks
keyframing, 127
using, 126–127

Share menu, options on, 158
shared projects, controlling, 163
sharing projects, 158–165. See also 

Compressor; projects
with Apple Applications, 158–159
Facebook, 163–164
posting videos on Web, 161–165
sending videos with Apple  

Mail, 161
via iTunes, 160–161
via Media Browser, 158–159
Vimeo, 162
YouTube, 164–165

Shift key. See keyboard shortcuts
shortcuts. See keyboard shortcuts
ShotPut Pro, 18
shutter speed, 7–8
skimmer, previewing clips with, 42
skipping forward and backward, 

166–167
Slide edit

with keyboard, 107
moving clips in Timeline, 

107–108
performing, 107–108

Slip edit
adjusting In and Out points, 

106–107
with keyboard, 106
performing, 106–107

Smart Collections
basing on search criteria, 52
changing contents of, 52
creating, 74
creating after analysis, 26
of synced footage, 74

snapping, toggling on and off, 91
software, considering, 16
soloing clips, 100, 144
sorting events, 38–39
sound bites, cutting, 78
Sound Devices audio recorders, 9
sound effects, adding, 140
speed change, Video Quality  

options, 135
Speed Ramp options, using, 134
speed segments

creating, 134
precision of last frame, 134
refining, 134
trimming to refine, 134

SSDs (Solid State Drives), 
considering, 16

Ripple edit
extending clips, 102–103
performing with keyboard, 

102–103
performing with Precision  

Editor, 107
shortening clips, 102–103

roles
assigning to clips, 43–44
Dialogue, 42
Effects, 42
keyboard shortcuts, 44
Music, 42
organizing clips with, 42–44
reassigning in Event Browser, 44
reassigning in Modify menu, 44
reassigning in Timeline Index, 44
rules, 43
searching for clips by, 51
setting up, 43
Titles, 42
Video, 42
viewing in Event Browser, 44
viewing in Info Inspector, 44
viewing in Modify menu, 44
viewing in Timeline Index, 44

Roll edit
changing timing between clips, 

103–104
performing on fly, 104
performing with keyboard, 104
performing with Precision  

Editor, 107
rolling shutter

analyzing video for, 26
repairing, 116, 129

S
SAN (storage area network), using, 61
saturation, adjusting, 123
scopes, 120

Histogram, 121
using, 119–121
Vectorscope, 120
Waveform Monitor, 120

SDHC Class 10 memory cards, 15
search criteria, basing Smart 

Collections on, 52
searching for clips, 50–51
segmentation, considering, 57
Select tool, adjusting timing of  

edits, 102
selections

accidental, 81
making, 81
working with, 78

project files. See also files
backing up, 172
copying, 172

Project Library, 60–61
project properties, checking, 60
projects. See also sharing projects

adding notes about, 61
adding still images to, 92
appending clips to, 82
audio properties, 59
backing up, 60
connecting clips to, 82
consolidating media for, 174–175
creating, 58
deleting, 63
duplicating, 62–63
exporting, 167–170
hiding, 62
inserting clips into, 82
modifying before editing, 60–61
moving or duplicating, 173–174
previewing, 62
render properties, 59
sending to Media Browser, 

158–159
switching, 62
video properties, 59

properties, checking for projects, 60
Properties Inspector, examining, 61
ProRes options, choosing for 

transcoding, 35
proxy media

choosing, 35
creating, 25

Q
quality modes, considering, 7

R
RAID editing drive, selecting, 20
ranges

deleting from Timeline, 99–100
selecting in Event Browser, 81
selecting in Timeline, 82

rating clips, 46–48
ratings, searching for clips by, 51
Rec 709 standard, 137
render files, deleting, 172–173
render properties, defining, 59
Replace edits

performing, 97–98
warning versus benefit, 98

resolution, explained, 4
reversing clips, 136
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Titles role, 42, 44
transcoding

Apple ProRes options, 35
considering, 25
optimized media, 25, 35
options, 35
proxy media, 25

transferring media
card reader, 17
computer selection, 15–16
connectivity, 16
creating disk images, 18–19
offloading cards, 17–18
portable drive, 16
software, 16

transitions
adding, 110–113
audio crossfade, 113
Available Media setting, 111
changing, 112
copying to edit points, 113
cross dissolve, 112
customizing, 112
Default Duration setting, 111
deleting, 113
detaching audio, 113
Full Overlap setting, 111
impact on show pacing, 111
listing, 113
overlap and handles, 111
preference settings, 111
video-only, 113

Transitions Browser, using, 112
trash

emptying, 53
moving projects to, 63

Trim tool
Roll edit points with, 103
switching to, 103

trimming edits, 101–108. See also 
advanced editing commands; edits

Ripple edit tool, 102–103
Roll edit, 103–104
Slide edit, 107–108
Slip edit, 106–107

trimming feedback, showing details of, 
105

U
UDMA memory cards, 15

V
Van Hurkman, Alexis, 126
Vectorscope, using, 120
video

adding only, 99
analyzing, 26
collapsing, 142
cutting sound bites, 78
deciding on starting point, 78
detaching audio from, 142
formats, 6
posting on Web, 161–165
sending with Apple Mail, 161
showing expanded, 142
syncing with audio, 67–73

video properties, deleting, 59
video quality, choosing, 35
Video role, 42, 44
video scopes. See scopes
video-based training, resource for, 

175
video-only transition, adding, 113
Vimeo, publishing projects to, 162

W
Waveform Monitor, using, 120
waveforms

displaying, 142
displaying in Timeline, 141
enabling subframe viewing, 143
turning on second set of, 141
viewing in greater details, 143

websites
Creative COW Forums, 175
Lynda.com, 175
RichardHarringtonBlog.com, 175
From Still to Motion, 175
Twitter, 175

Y
YouTube, publishing projects to, 

164–165

Z
Zoom audio recorders, 9
zooming in Timeline, 69, 87, 90

stabilization, analyzing video for, 26
stereo audio, grouping, 27
stereo channel, configuring, 145
still images. See also photos

adding to projects, 92
default duration, 92
exporting, 168–169
recompressing, 26

storage area network (SAN), using, 61
stories, enhancing, 78
storyline, primary, 83, 88
sync command, troubleshooting, 68
sync point, finding, 70
synced footage, creating Smart 

Collections of, 74. See also footage
Synchronize Clips keyboard shortcut, 

68–69, 71
syncing footage

clips automatically, 67–68
interviews automatically, 70–71
with markers, 69
multiple cameras, 71–73
turning off bad tracks, 73
using best audio, 73

T
Tascam audio recorders, 9
timecode. See also drop frame 

timecode
changing, 59
displaying for clips, 80
setting, 58

timecode value, entering to move 
clips, 88

Timeline
adding clips to, 82–85
adjusting settings, 91
arranging clips in, 86–90
deleting clips from, 99–100
deleting ranges from, 99–100
displaying audio waveforms in, 

141
dragging to, 58
holding space in, 84–85
mixing formats in, 131–133
modifying audio in, 146–147
moving clips in, 107–108
navigation techniques, 91
removing clips from, 82–85
scrolling in, 90
selecting ranges in, 82
zooming in, 87, 90

Timeline Index
navigating Timeline with, 92–93
reassigning roles in, 44
viewing roles in, 44
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